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B
efore we get into how this book works, what it’s all about, and the boring stuff that usually winds up in

introductions, I want to say right up front that you’re going to have so much fun with this book,

you’re going to absolutely lose your mind.

I know it sounds crazy, but this book is going to change your life. Because after reading and applying the

techniques learned here, you’ll be able to walk in the door of virtually any secret underground religious cult,

and they’ll take you as a member—no questions asked, right on the spot. Not only that, you’ll put up little or

no resistance whatsoever when asked to sign over all your personal belongings, and you’ll willingly agree to

cut off all contact with your family and friends because after all, they no longer share your glorious dream of

becoming “one with the pixel.” They’re “outsiders,” “nonbelievers,” and therefore can’t be trusted.

What’s more amazing is that I was able to find both professional editors and a respected publisher to let me

start the introduction of my book with this whole “cult” thing. You know what that says to me? Even they don’t

read book introductions. But you, you’re different, you’re a rebel—someone who looks convention in the face

and then quickly looks away, so as not to be rude. You’re ready for a different kind of Photoshop book. An edgy

Photoshop book: A Photoshop book that takes risks—just like you.

You don’t want chapter after chapter waxing philosophical about resolution, color management, file formats

(and the women who love them). You don’t want lengthy technical explanations of how each tool mathemati-

cally interacts before you’re allowed to touch any of them. No, that’s not you. You’re alive. You’re unbound. You

want to do the cool stuff now! You want to sit down in front of your computer and the next time you look up,

it’s 4:15 in the morning—you’ve been up all night, and you don’t even care. Why? Because you’ve been having

a blast (and because you’re going to bill your client for every minute). When your client gets the invoice, there’s

a reasonable chance they’ll black out, perhaps more than once, but it’ll all be worth it when they see your work.

That’s what this book is all about—teaching you the coolest special effects that will blow your clients away,

make you truckloads of money, and give you the most fun you’ve ever had using Photoshop—without all the

boring technical stuff.

If this is who you are. If this is who you want to be. This, my friend, is the book for you. Embrace it. Feel it.

Feed it (feed it?). But what if this isn’t who you are, and not who you want to be? Buy this book anyway. It’s

good for the economy.

How this book works

Think of this as a “Photoshop special effects cookbook.” Need to create a studio backdrop for a product

shot? Turn to page 177. Need a cool chrome effect for an ad? Turn to page 104. Need to do cool stuff

right now, for a project due tomorrow? Just turn to the page that has the effect you need, and follow the

step-by-step instructions.

You’ll be able to re-create every technique in this book, regardless of your level of Photoshop experience,

and you’ll unlock the secrets for creating today’s hottest Photoshop effects—the same ones you see in national

magazines, on TV, and on the Web that would otherwise have taken years to learn, but are simple—once you

know the secrets. You’ll be absolutely amazed at how easy these tricks really are, and they’re all here, including

those closely guarded “insider tips” and down and dirty tricks of the trade. There are no years of study, no

complex mathematical concepts to master, no baloney. It’s (as we say) “Just the funk and not the junk!”

I N T R O D U C T I O N
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Okay, so now you know what the book is all about—special effects and cool tricks—but you probably have

other questions. Probing, lingering personal questions whose answers may be too uncomfortable for our studio

audience, so instead I thought we’d do something safer—a simple Q&A section where I make up the questions

I’d like to have answered if I was the person buying this book, and then I answer them, as if I’d written the book

(which coincidentally, I did). If this sounds at all confusing, it should. Here we go:

Q. Where should I start in the book?

A. Honestly, it doesn’t matter. This book isn’t designed to be read like a novel, starting with chapter 1, then

chapter 2, etc.—this is a jump-in-anywhere book and start “effecting.” To learn a little bit more about what’s

in each chapter, make sure you read the chapter intros. I say “a little” more, because I wrote those at about

2:00 a.m., and I was half in the bag (I mean, quite tired after many hours of work). Also, if you’re a seasoned

Photoshop user, don’t be put off because I give full explanations of steps in the tutorials. For example, instead

of just saying “Create a new layer” I generally say “Create a new layer by clicking on the New Layer icon at the

bottom of the Layers palette.” I do that because I want any user, at any level of Photoshop experience, to be able

to jump in any place in the book and pull off the technique. There’s no “intro to Photoshop” chapter—I figured

if you bought this book, instead of one of those 1,000-page “learn everything about Photoshop” books, you

want to do the cool stuff now, so I start on page 1 with the first special effect and I don’t stop again until the

back cover. (Okay, they made me put an index in the back, but wouldn’t you really rather have had another

special effect instead? Come on, admit it. See, I knew this book was for you!)

Q. How is this book different from your 6.0 book?

A. This book is better (you knew I was going to say that. Heck, even I knew that you knew that I was going to

say that). In fact, not even taking into account all the new Photoshop 7 stuff, I think it’s a much better book.

It’s yummier, cooler, rockin’-er—anything good you can think of ending with an “-er.” That’s what this book is.

I’ve learned a lot of slick, new effects since I wrote the last version of this book, and I’ve been fortunate enough

to have Photoshop users all over the world send me some of their favorite tips and techniques as well, so there’s

a lot of brand-new stuff in this book. But...I also updated some of the most popular effects from the 6.0 version

of the book as well. In many cases, I’ve found easier ways to do them, interesting new ways to use them, some

little shortcuts that make them more fun, and basically I just can’t stop trying to find ways to make them even

better. It’s a sickness.

Q. Where do all these cool effects come from?

A. France.

Q. No, really, where do they come from?

A. Actually, the book is a combination of a lot of different things. The whole “Down & Dirty” concept started

back in 1993 with a session I did called “Photoshop Down & Dirty Tricks” at a Photoshop seminar held in Ft.

Lauderdale, Florida. It turned out to be the hit of the seminar, and I think the reason it resonated with the

crowd was that I was teaching them the exact same things I’d been trying so hard to learn just a few months

I N T R O D U C T I O N  ( c o n t i n u e d )
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earlier. At the time, I had my own “wish list” of Photoshop effects that I wanted to learn, and once I learned

them, I couldn’t wait to share them with other Photoshop users. We had fun that day. We laughed, we cried

(okay, I cried), we learned, and at the end of the day, I don’t know who was more excited, the attendees or

me, but I knew then that this is what I wanted to do.

It’s nine years later and I still do a constantly updated version of the “Photoshop Down & Dirty Tricks”

session live at the Adobe Photoshop Seminar Tour as well as at PhotoshopWorld. Out of those sessions came

my best-selling Photoshop “Down & Dirty Tricks” video series, and some of my favorite techniques from

there are here too. I also included techniques from the “Down & Dirty Tricks” column that I write with Felix

Nelson in Photoshop User magazine, and I included lots of new Down & Dirty Tricks that I’ve never done

anywhere else. In short, this book takes some of my favorite Photoshop techniques and combines them all

into one resource. It’s the book that I wish I’d found when I was trying to learn these types of effects, and I’m

thrilled to be able to bring this new updated version to you.

Actually, finding ideas for new Photoshop effects is easy because Photoshop is literally everywhere. Open

a magazine, look at TV, or just drive down the street and look at the billboards—you’re looking at

Photoshop work. There are two things about that reality that I truly love: (1) figuring out how they did those

effects, and (2) sharing how they did them with other people like yourself. It’s how I get my kicks. That, and

doing crack—kidding (you knew that, right?).

Q. This book has lots of cool images, do I get those too?

A. You’re kinda greedy, aren’t you? Okay, you can have the images. Here’s the scoop: When I was preparing to

write this new version of the book, as you might imagine, I wanted it to have great-looking images, and that’s

why I asked Digital Vision if I could use their royalty-free stock images in the book. I honestly feel that they

have the hottest royalty-free images in the market today and that’s why I contacted them, and only them, to

arrange to use their images.

Luckily, besides having the hottest images, they’re incredibly nice people and I was able to use that to

guilt them into letting you download the images used in the book from the book’s companion Web site at

www.downanddirtytricks.com. How cool are Digital Visions images? Why don’t you see for yourself at

www.digitalvisiononline.com? In particular, make sure you check out their Infinity collection to see some of

the hottest, cutting-edge work from Europe’s smartest young designers. Yes, that’s totally a plug, but they

didn’t ask me to do it. (If they had, I would have, but they didn’t.)

Now, you may also notice that there are some photos in the book that are, well…not quite as good as

others. For example, there’s a head shot of Felix taken outside our offices. Believe it or not, that’s not a

royalty-free image from Digital Vision (although it certainly should be). In certain cases, we took some

snapshots using our trusty (rusty? crusty?) digital camera, so any photo that doesn’t look really slick is

probably one of those—and not from Digital Vision. We let you download those photos as well. Please be

kind to them (i.e., don’t use Liquify on them)...especially the one of Felix.

I wanted any
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Photoshop

experience, to

be able to jump
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in the book

and pull off
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Q. Okay, who is Felix?

A. Felix Nelson is about the coolest, most creative, Photoshop guy in the world. He’s the  Creative Director

for Photoshop User, and Art Director for Mac Design Magazine, and he has an amazing ability to do things

in Photoshop that I can’t even begin to understand. I’m fortunate  to work with Felix every day and I have

to honestly say that I learn more about Photoshop from Felix than from anyone else on the planet, and I’m

delighted to pass on some of his ideas and techniques throughout the book.

Q. Is this for Mac, Windows, or both?

A. Both! It covers the Macintosh and PC versions of Photoshop. (Honestly, it was pretty easy because

Photoshop is identical on both the Macintosh and PC platforms.) However, even though the software is the

same, the Mac and PC keyboards are slightly different so every time I give a keyboard shortcut in the book,

I give both Mac and PC keyboard shortcuts...see, I care.

Q. What are in those sidebars on every page?

A. In the previous version of this book, I put a Photoshop tip on every page. Some were little shortcuts, some

were timesavers, some were just advice (stocks, mutual funds, relationships, etc.), and as best as I can tell—

nobody really noticed. Everybody got sucked into all the cool special effects and figured the sidebars hid all

the boring technical stuff, instead of cool tips. So when I started updating the book, my first thought was to

pull out all the tips because, frankly, it’s hard coming up with almost 300 tips. But when Felix heard I was

taking out the tips, he started whining, “Ahhh man, you can’t take those out—I thought that was the coolest

part—it’s a special effects book, but it also had hundreds of sidebar tips.” So, I left ’em in, added some new

ones for Photoshop 7, and replaced any lame ones. I’m counting on you to do your part and read at least

some of them. I even added the header, “Quick Tip,” to each one hoping they’d catch your attention. These

are the acts of a desperate tips man.

Q. What if I’m still using Photoshop 6?

A. Well, then it’s time to upgrade—big time—because honestly, Photoshop 7 blows Photoshop 6 out of the

water, especially if you’re a photographer. In the meantime, if you still have 6, you can use this book and get

a lot out of it until you do upgrade (which, incidentally,  you should do tonight).

So why is it that a Photoshop 6 user would use this Photoshop 7 book? It’s because a lot of the things

Adobe added to Photoshop 7 weren’t special effects-related. For example, there aren’t many cool effects you

can do with the spell checker. I love the spell checker; I crave the spell checker. Apparently, I desperately need

a spell checker, but I can’t teach you really cool smoke effects, flames, or chrome effects with the spell

checker—sad, but true. Photoshop 7 was a major productivity upgrade, with cool stuff like the File Browser

(great for photographers, but again, makes for a lame special effect), the absolutely amazing Healing Brush

(the best tool for photo retouching ever, but as a special effects tool, it’s no drop shadow), Mac OS X and

Windows XP Support (again, no glass, no metal, no flames) and the hundred or so other tweaks, fixes, new

features, improvements, and enhancements that make it the best overall Photoshop ever. That’s why I

included lots of sidebar tips on cool new stuff in Photoshop 7 throughout the book, and of course, the

I N T R O D U C T I O N  ( c o n t i n u e d )

You’re now

ready to enter a

world of special

effects delights

that dare not

speak its

name...

4



tutorials in the whole book were done using Photoshop 7 (hence the book’s name). Now, what if you’re

using Photoshop 5.5 or 5.0? Don’t tell anyone, just hide yourself away in a tower somewhere until you can

upgrade to Photoshop 7.

Q. Blah, blah, blah. Enough already, eh?

A. You’re right, I’ve said enough. You’re now ready to enter a world of special effects delights that dare not

speak its name. A world where drop shadows intermingle with bevels amidst a starry sky created entirely

with the Noise filter and a tasteful hint of Gaussian Blur. This is your world. This is your time. Launch

Photoshop, go forth, and make cool stuff that will generate client invoices so large it would make a govern-

ment military contractor blush.

Q. What’s the Web site again?

A. The book’s companion Web site is at www.downanddirtytricks.com. It’s where you can download

the images used in the book, and if you go there, it will save me the trouble of publicly plugging my other

books, including Photoshop Photo-Retouching Secrets and Photoshop Killer Tips (I couldn’t help myself), now

quick, turn the page before I plug again...

Have fun kids, and don’t stay up too late.

5
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Suspicious Characters
Cool Type Effects

I know what you’re thinking. Are the

techniques in this chapter really

“cool effects,” or is this just marketing hype?

First, I want to point out that there are strict

guidelines set in place by a large, scary-

sounding government agency to make sure

that when a claim is made about a particular

product, the claim is true. So, to substantiate

the fact that these type effects are indeed

worthy of the glitzy marketing term “cool,”

I formed a blue-ribbon panel that was

charged with putting together a crack team

of addicts to find Arthur Fonzarelli and get

his full endorsement of these effects. Sadly,

the panel was not able to locate Mr. Fonzarelli

within the allotted time. However, a woman

identified only as Pinky Tuscadero, with

whom he was once romantically linked, did

render her expert opinion in his stead.  Her

opinion proved beyond reasonable doubt

that the effects in this chapter would be

considered by Mr. Fonzarelli, or any of the

Happy Days’  cast (with the notable

exception of Chachi), to be “cool effects.“

I think that pretty much settles it.
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8 Photoshop 7 Down & Dirty Tricks

If you’ve applied a filter

and you want to reapply

the same filter with

different settings, there’s a

keyboard shortcut for just

that. You can bring up the

dialog box for the last

filter you ran, with the

same settings you last

used, by pressing Option-

Command-F (PC: Alt-

Control-F).

If you want to reapply

the last filter using the

exact same settings, just

press Command-F (PC:

Control-F).

Quick Tip:
The old “Bring up
the last filter
dialog box” trick

Stroke Effects on Type
The inspiration for this effect came from my pantry, when one day I noticed that the logo on the large

bag (yes, the large bag) of Oreo® cookies totally rocked. It had bevels, strokes, shadows, and a yummy

filling sandwiched between two chocolate cookies. I’m not ashamed to admit that I gained six pounds

while researching this technique (which required numerous large bags of Oreos).

STEP ONE: Open a new

document at 150 ppi in RGB

mode. Press “g” to get the

Gradient tool, then up in the

Options Bar, click on the

Gradient thumbnail to bring up

the Gradient Editor. Click on the

third gradient under Presets

(the Black to White gradient).

STEP THREE: Press “d” then “x” to

set your Foreground color to

white. Then press “t” to switch

to the Type tool, and enter your

type. (The font used here is

Futura Extra Bold. I also set the

Horizontal Scaling to 120% in

the Character palette).

STEP TWO: Double-click on the

left (black) Color Stop. When

the Color Picker appears, click

on the Custom button, choose

PANTONE 654, and click OK.

Next, double-click on the right

(white) Color Stop. When the

Color Picker appears, choose

PANTONE 631. Give this

gradient a name, and then

press the New button to Save it.

Drag this gradient within your

Background layer as shown.
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Although most of the

Layer Styles are often

thought of as filter effects

(e.g., glows, bevels, drop

shadows, etc.), it’s

important to understand

that you ARE NOT

applying a filter. You are

applying an effect to an

entire layer. For example,

let’s say you have an

image of a basketball on

its own layer, and you

apply the Drop Shadow

Layer Style to that layer.

Once you’ve done that,

anything else you do to

that layer will also have

the exact same drop

shadow as the basketball.

Paint a brush stroke?

Boom, it has a drop

shadow. Drag a square

selection and fill it with a

blur? Boom—another

drop shadow. Remember

they’re called Layer Styles

because they affect the

entire layer.

Quick Tip:
Understanding
Layer Styles

STEP FOUR: In the Layer’s

palette, double-click directly on

the “T” thumbnail of your Type

layer to have Photoshop

automatically highlight your

type. From the Options Bar,

click on the Warp Text icon (it

looks like a “T” with a half circle

under it). When the dialog

appears, choose Arc for Style.

Lower the Bend to 8%, lower

the Horizontal Distortion to

–13% (as shown), and click OK.

STEP FIVE: Press Command-T

(PC: Control-T) to bring up Free

Transform. Rotate the word a

little counterclockwise, then

hold the Command key (PC:

Control key), grab the top

center point, and drag to the

left to Skew the entire word to

the left. When it looks like the

type shown here, press Return

(PC: Enter) to complete the

transformation.

STEP SIX: To apply a drop

shadow, choose Drop Shadow

from the Layer Styles pop-up

menu at the bottom of the

Layers palette. Enter 10 for

both Distance and Size and

click OK.

continued
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Have you ever applied the

Outer Glow or Inner Glow

Layer Style and didn’t see

the glow appear on

screen—even after you

increased the Size to 20

or 30 pixels? That’s

because by default the

Blend Mode for the Glow

Layer Style is set to

Screen. In many cases,

depending on what you

have on the layers

beneath your Glow layer,

you won’t be able to see

the glow at all. The way

around it? Just change

the Blend Mode (in the

Glow Layer Style dialog

box) from Screen to

Normal. Then, increasing

the Size and Spread

amount will make a

visible difference.

Quick Tip:
Making the Glow
Layer Style work

STEP SEVEN: Choose Bevel and

Emboss from the Layer Styles

pop-up menu at the bottom of

the Layers palette. Increase the

Depth to 201%, the Size to 15,

and Soften to 2. Lower the

Opacity of the Shadow to 50%

and click OK to apply a wide

bevel to your Type layer.

STEP NINE: Press “w” to switch

to the Magic Wand. You’ll notice

(in the capture in Step Eight)

that the centers of the letters

are selected, but unfortunately

we don’t want that, so just

hold the Shift key and click the

Magic Wand tool once inside

each of the two “O’s” to remove

those selections.

STEP EIGHT: Hold the Com-

mand key (PC: Control key) and

in the Layers palette, click once

on your Type layer to put a

selection around your type.

Then, go under the Select

menu, under Modify, and

choose Expand. When the

dialog box appears, Expand by

16 pixels and click OK to

increase the size of your

selection (as shown).
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STEP TEN: Your selection should

still be in place. Create a new

blank layer by clicking on the

New Layer icon at the bottom

of the Layers palette. Then, go

under the Edit menu and

choose Stroke. When the Stroke

dialog box appears, for Width

enter 8, and for Location

choose Inside, then click OK to

apply an 8-pixel black stroke

around your selection.

Deselect by pressing

Command-D (PC: Control-D).

STEP ELEVEN: Choose Bevel

and Emboss from the Layer

Styles pop-up menu at the

bottom of the Layers palette.

Increase the Depth to 400%,

and the Size to 10. Click on the

down-facing triangle next to

the Gloss Contour sample to

bring up the Contour Picker.

Choose the same contour

shown in the inset at left

(called Rounded Steps), turn

on Anti-aliased, and click OK

to apply the bevel to your

black stroke.

STEP TWELVE: Choose Color

Overlay from the Layer Styles

pop-up menu at the bottom of

the Layers palette. When the

dialog box appears, click on the

Color Swatch, then click on the

Custom button in the Color

Picker, choose PANTONE 7461,

and click OK to apply a bright

blue color to cover your black

beveled stroke (as shown here).

If your palettes are

cluttering your work area,

here’s a quick tip to tuck

them safely off to the side.

Just hold the Shift key and

double-click on the

palette’s title bar. It will

instantly snap to the

nearest edge of your

screen, opening up the

work area in the center of

your screen.

Quick Tip:
Get those palettes
out of the way

continued
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STEP THIRTEEN: Hold the

Command key (PC: Control key)

and in the Layers palette, click

on your original Type layer  to

put a selection around your

type (make sure to also select

the centers of the “O’s”). Go

under the Select menu, under

Modify, and choose Expand.

Enter 18 pixels and click OK.

Create a new blank layer. Press

“d” to set your Foreground

color to black, then press

Option-Delete (PC: Alt-

Backspace) to fill this layer with

black. In the Layers palette,

drag this black layer behind

your original Type layer.

STEP FIFTEEN: Choose Gradient

Overlay from the Layer Styles

pop-up menu at the bottom of

the Layers palette. Click on the

Gradient thumbnail and in the

Gradient Picker, choose the

original gradient you created in

Step Two. For Style, choose

Reflected and check the

Reverse box. For Angle, choose

4°, and click OK to apply this

gradient over your black fill.

STEP FOURTEEN: Deselect by

pressing Command-D (PC:

Control-D). Choose Drop

Shadow from the Layer Styles

pop-up menu at the bottom of

the Layers palette. Lower the

Opacity to 65%, increase the

Distance to 30 and the Size to

40, and click OK to apply a soft

drop shadow to your black

layer. Click OK.

This is one of those little-

known shortcuts that can

be a great timesaver.

When you open any of

Photoshop’s Preference

dialogs (General Prefer-

ences, Plug-ins & Scratch

Disks, Units & Rulers, etc.),

just press Command-N

(PC: Control-N) and the

next set of Preferences

will appear in the current

dialog. To toggle back to

the previous Preference,

just press Command-P

(PC: Control-P).

Quick Tip:
Toggle through
your Preferences
windows
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STEP SIXTEEN: Choose Stroke

from the Layer Styles pop-up

menu at the bottom of the

Layers palette. All you’re going

to do in this dialog box is

to change the color from its

default of red to white (by

clicking on the Color Swatch

and choosing white in the

Color Picker), then click OK to

apply a white stroke around

your layer.

STEP SEVENTEEN: In the Layers

palette, click in the second

column beside Layers 1 and 2

(the top layer and the bottom

layer below the original text)

to link them together.

STEP EIGHTEEN: Press “v” to

switch to the Move tool, then

press the Left Arrow key twice,

and the Down Arrow key twice,

to offset the Bevel effect layers

from the type to complete

the effect.

The Tracking control (in

the Character palette)

controls the amount of

space between your

letters. A negative setting

moves your letters closer

together, a positive

number moves them

farther apart. If you’re like

me, you’re constantly

tweaking this spacing, and

if you’re like me, you’ll be

as happy as I was when I

learned that you can reset

the tracking back to zero

for your selected type by

simply pressing Shift-

Command-Q (PC: Shift-

Control-Q). The only catch

is—your type has to be

highlighted (which frankly

is weird because you can

increase or decrease the

amount of tracking

anytime the type layer is

selected, but unless the

type is highlighted that

keyboard shortcut

doesn’t work. (See, it is

weird isn’t it?)

Quick Tip:
Setting your
tracking back to 0
(its default)
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The Type Mask tool

creates selections in the

shape of type, rather than

type itself (like the regular

Type tool). If you prefer to

use the regular Type tool

to create a type-shaped

selection, you can. In fact,

I prefer it because you can

really see what your type

is going to look like.

Just create your type as

usual, hold the Command

key (PC: Control key), and

click once on the Type

layer’s name in the Layers

palette. This puts a

selection around your

type. Now you can drag

your Type layer into the

Trash at the bottom of the

Layers palette. So what

are you left with? That’s

right, a selection in the

shape of your type—

exactly like what the Type

Mask tool would’ve done.

Quick Tip:
Alternatives to the
Type Mask tool

Totally Distressed Type Effect
This is my version of a technique I first picked up from Kris Hunt at The Screaming Banana for

giving type that beaten-up, weathered look that’s all the rage, especially in Hollywood (HBO uses

a similar effect for their excellent Band of Brothers series). The version shown here lets you do

most of the set-up in layers, so you’re hardly working in channels at all.

STEP ONE: Open a new

document (RGB or Grayscale—

your choice). Set your Fore-

ground color to black by

pressing the letter “d.” Using

the Type tool, set some very

large type (in this example,

I used the font Compacta

Bold set at 120 points). This

technique works equally well

with a placed EPS logo, as long

as the logo is black.

STEP TWO: Create a new blank

layer by clicking on the New

Layer icon at the bottom of

the Layers palette. Now, hide

your Type/logo layer by

clicking on the Eye icon in the

first column to the left of that

layer. Don’t actually change

layers, just hide the type layer

from view (as shown).

STEP THREE: Press Shift-U until

the Line tool appears in the

Toolbox. Up in the Options Bar,

click on the third tiny icon from

the left (as shown) to create

lines with pixels, rather than a

shape layer. Also, set your line

Weight to 2 pixels (as shown).
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Tired of digging through

the Layer menu to

rasterize your type? Here’s

a shortcut: Go to the

Layers palette, hold the

Control key (PC: Right-

click), and click-and-hold

on your Type layer. A

contextual pop-up menu

will appear where you

can choose Rasterize

Layer. No more digging!

Quick Tip:
A faster way to
rasterize your
Type layer

STEP FIVE: Deselect by

pressing Command-D (PC:

Control-D), and then press “u”

to switch back to the Line tool.

In the Options Bar, increase the

Weight to 4. Then draw

another series of lines, only

about half as many as the first

time, and anywhere from one-

half to three-quarters as long

as the others. Also, draw these

directly beside the existing

lines (as shown).

STEP FOUR: Draw a vertical line

on the left side of your image

area, from top to bottom.

Command-click (PC: Control-

click) on the layer’s name (in

the Layers palette) to put a

selection around your line.

Press “v” to get the Move tool,

then hold Option-Command

(PC: Alt-Control), click directly

on your line, and drag to the

right to make a duplicate of

your line. Create a pattern

of randomly spaced lines as

shown here (all on that new

blank layer you created).

STEP SIX: Command-click (PC:

Control-click) on the Layer’s

name (in the Layers palette) to

put a selection around all the

lines on your Layer. Go under

the Select menu and choose

Save Selection. When the Save

Selection dialog box appears,

simply click OK and your

selection will be saved as an

Alpha Channel in your

Channels palette.

continued
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STEP SEVEN: Deselect by

pressing Command-D (PC:

Control-D) and drag your lines

layer into the Trash at the

bottom of the Layers palette to

delete it. Go to the Channels

palette and click on Alpha 1

(your saved lines channel).

Your lines will appear white on

black, so you’ll have to press

Command-I (PC: Control-I) to

invert them so they’re back to

black lines on a white back-

ground.

STEP EIGHT: Go under the

Filter menu, under Pixelate,

and choose Mezzotint. When

the dialog box appears,

from the Type pop-up menu

choose Coarse Dots, then click

OK to add some trauma to

your lines. Then, to minimize

the trauma (you want some,

but not this much), go under

the Edit menu and choose

Fade Mezzotint. When the

Fade dialog appears (shown

right), change the Mode

from Normal to Screen, and

click OK.

STEP NINE: Choose the

Mezzotint filter again, but this

time from the Type pop-up

menu choose Medium Strokes,

then click OK to add some

horizontal trauma. Again, it’s a

bit too much, so go under the

Edit menu and choose Fade

Mezzotint. When the Fade

dialog appears, lower the

Opacity to 50%, and click OK.

Okay, this one’s pretty

freaky: You probably

already know that if you

hold the Command-key

(PC: Control-key) and click

on a Layer’s name (in the

Layers palette, it puts a

selection around the

objects on that layer. So

for example, if you had

type on a layer, and

Command-clicked (PC:

Control-clicked) on the

Type layer, it would put a

selection around all your

type. But here’s the

“esoteric selection

shortcut” of the month: If

after loading that

selection, you then press

Shift-Option-Command

and click on another layer

(in the Layers palette), it

will load a selection that

intersects with your

original selection. Try it

once and if you’re like me,

you’ll wonder “When in

the world would I use

that?” Hey…I don’t make

these keyboard shortcuts,

I just share them with

my “peeps.”

Quick Tip:
Esoteric selection
shortcut of the
month
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STEP TEN: Go to the Layers

palette and click on your Type

logo layer to make it active

(as shown).

STEP ELEVEN: Go under the

Select menu and choose Load

Selection. When the dialog

box appears, under Channel,

choose Alpha 1 from the pop-

up menu, and click OK to load

your lines as a selection (as

shown).

STEP TWELVE: Lastly, to get

your lines to appear in white,

solely within your black type,

go under the Layer menu,

under Add Layer Mask, and

choose Reveal Selection. If you

want to reposition your lines to

better suit the text, in the

Layers palette, click on the link

icon between your layer

thumbnail and the Layer Mask

thumbnail, and then use the

Move tool to move your Mask

into position.

OK, this is really more of

a half-truth. Here’s the

scoop: When you shrink

the Canvas Size of your

document (basically,

you’re cropping down the

image without using the

Crop tool), you get a

warning dialog that reads

“The new canvas size is

smaller than the current

canvas size. Some clipping

will occur.” If you go ahead

and click the “Proceed”

button, your new smaller,

canvas size will appear.

Here’s the thing: Let’s say

you had a type layer with

the word “Washington,”

on it, and when you took

3” off your Width in the

Canvas Size dialog, all that

was left on screen is

“shingt” (it clipped off the

left and the right side),

you’re really not as out-of-

luck as Photoshop’s

warning dialog makes you

think.  That’s because

although you can’t see it,

the rest of the word was

not deleted—it’s just

hidden from view. Grab

the Move tool and drag

your type left (or right)

and you’ll see the rest

of your supposedly

“clipped-off” word.

Quick Tip:
Canvas Size lies!


